
ProJet™ 1200
Professional 3D Printer

User Guide
Original Instructions



i3D Systems, Inc.

CONTENTS

INTRODUCTION. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  1

WARRANTY. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2
LIMITATION OF LIABILITY. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2

IMPORTANT SAFETY INFORMATION. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  3

SAFETY SYMBOLS AND DEFINITIONS. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3
HIGH VOLTAGE POTENTIAL & ELECTRICAL SAFETY. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4
ULTRAVIOLET (UV) SAFETY. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4
CONSUMABLE SAFETY GUIDELINES. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 5

VisiJet® FTX Green Cartridge. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  5
VisiJet FTX Green Cartridge Removal. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  5
VisiJet FTX Green Material Disposal. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  5
VisiJet FTX Green Material Handling. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  5
VisiJet FTX Green Material Safety. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  5
VisiJet® FTX Green Material Usage . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  6

ULTRAVIOLET (UV) SAFETY. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 6

AT-A-GLANCE. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  7

About the Printer. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  7

Connections. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  8

SPECIFICATIONS AND REQUIREMENTS . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  9

Specifications. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  9

Printer . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  9

UNPACKING AND SETTING UP YOUR PROJET 1200. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  10

Contents. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  10

Unpacking The ProJet 1200. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 11

Printer Setup. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  14

Installing the Curing Bulb. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  14

Installing the Material Cartridge. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  16

Installing the Print Platform. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  17

Installing the ProJet 1200 Software. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  19

Connecting The Printer. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  21

CONNECTING PRINTER USING A USB CONNECTION. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  21

OPERATING THE PRINTER. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  23

Software Overview. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  23

File Dropdown Menu. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  24

Edit Dropdown Menu. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  25

View Dropdown Menu. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  26

Tools Dropdown Menu. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  26

Options Dropdown Menu. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27

Help Dropdown Menu. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27

Main Toolbar . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  27

View Toolbar . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  28

Edit Toolbar. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  28

Tools Toolbar. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  29



ii3D Systems, Inc.

Printing A Part . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  29

Remove the Part from the Printer. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  31

Cleaning Parts . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  32

Cleaning Parts by Manually Dipping. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  33

Cleaning Parts using an Ultrasonic Cleaner . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  33

Special Consideration when Cleaning Parts. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  34

Changing the Isopropyl Alcohol in Containers 1 and 2 . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  34

Cleaning Parts with 70% Isopropyl Alcohol. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  34

Cure and Post Process the Part. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35

USER MAINTENANCE. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36

Replacing the Curing Bulb. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36

Cleaning the Unit . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  37

SERVICE AND SUPPORT . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  38



13D Systems, Inc.

1 	 INTRODUCTION

Thank you for purchasing the ProJet® 1200 3D printer. 

The ProJet 1200 professional 3D Printer produces small, detailed parts for casting, prototyping and end-use parts from 3-D solid 
Computer-Aided Design (CAD) models. It is intended to be used as a 3-dimensional output device to communicate design intent with 
durable, physical parts. Parts produced can be used in all phases of design, from a concept build to functional testing and assembly 
verification. For example, a part can be used as a tool to communicate design intent, to verify the fit of a new or existing component part 
or to create a rugged, plastic prototype of a new invention. Parts made on the ProJet 1200 are ideal for dental wax-ups, jewelry and 
other castings, and durable, stiff parts are also great for plastic prototypes.

These parts are generated in the rapid prototyping (RP) environment under the control of the printer operators. It does not require a 
special technical staff to supervise the system. All design and process considerations are compatible with an RP environment. The 
three-dimensional solid parts that are printed consist of an ultraviolet (UV) curable material. The resin transfer mechanism provides a 
controlled layer thickness of VisiJet® part material which is deposited and patterned using a proprietary imager technology which 3D 
Systems® has developed. When creating the pattern, the VisiJet® material undergoes a phase change. This phase change converts 
the liquid material into a solid polymer. When the print is complete, the part adheres to the print pad. This pad along with the part is 
removed from the print platform and the part is cleaned and cured to provide a finished part.

COPYRIGHT

©2014 by 3D Systems®. All rights reserved.

Under the copyright laws, this user guide may not be copied, in whole or in part, without the written consent of 3D Systems. The ProJet  
logo is a trademark of 3D Systems and is registered in the U.S. Use of this logo without the prior written consent of 3D Systems may 
constitute trademark infringement and unfair competition in violation of federal and state laws.

Every effort has been made to ensure that the information in this manual is accurate. Other company and product names mentioned 
herein are trademarks of their respective companies. Mention of third-party products is for informational purposes only and constitutes 
neither an endorsement nor a recommendation.

The product described in this user guide incorporates copyright protection technology that is protected by method claims of certain U.S. 
and foreign patents and other intellectual property rights that are owned by 3D Systems®. Reverse engineering is prohibited.

VisiJet® is a registered trademark of 3D Systems.

FCC NOTICE

This equipment has been tested and found to comply with the limits for a class “A” digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against harmful interference. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference 
to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user 
will be required to correct the interference at their expense.

COMPLIANCE

This equipment conforms with International Electric Committee (IEC) 60950-1 and meets the requirements of the applicable EC 
directives.
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WARRANTY
3D Systems warrants that the ProJet 1200 3D Printer will be free from defects in materials and workmanship, during the applicable 
warranty period, when used under the normal conditions described in the documentation provided to you, including this User Guide.  
3D Systems or its authorized service provider will promptly repair or replace the ProJet 1200 3D Printer, if required, to make it free of 
defects during the warranty period.This warranty excludes (i) normal consumable or expendable parts (such as Material Cartridges), (ii) 
repairs required during the warranty period because of abnormal use or conditions (such as riots, floods, misuse, neglect or improper 
service by anyone except 3D Systems or its authorized service provider), and (iii) repairs required during the warranty period because 
of the use of non-integrated, non-approved or non-licensed materials with the ProJet 1200 3D Printer.  The warranty period for the 
ProJet 1200 3D printer is for one (1) year and starts at the earliest of (i) the date your ProJet 1200 3D printer is activated or (ii) “ninety 
(90) days after the ProJet 1200 3D Printer is shipped from 3D Systems to the end customer or to the reseller or retailer that sold the 
ProJet 1200 3D Printer to the end customer.”

THIS WARRANTY IS THE ONLY WARRANTY PROVIDED FOR THE PROJET 1200 3D PRINTER.  TO THE MAXIMUM EXTENT 
PERMITTED BY LAW, 3D SYSTEMS EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES FOR THE PROJET 1200 PRINTER 
AND EACH OF ITS COMPONENTS, WHETHER THOSE WARRANTIES ARE EXPRESS, IMPLIED OR STATUTORY, INCLUDING 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR INTENDED OR PARTICULAR PURPOSES.

LIMITATION OF LIABILITY
3D SYSTEMS WILL NOT BE RESPONSIBLE FOR INDIRECT, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR INCIDENTAL 
DAMAGES (SUCH AS LOSS OF PROFIT OR EMPLOYEE’S TIME) REGARDLESS OF THE REASON.  IN NO EVENT SHALL THE 
LIABILITY AND/OR OBLIGATIONS OF 3D SYSTEMS ARISING OUT OF THE PURCHASE, LEASE, LICENSE AND/OR USE OF THE 
EQUIPMENT BY YOU OR OTHERS EXCEED THE PURCHASE PRICE OF THE PROJET 1200 3D PRINTER.



33D Systems, Inc.

2 	 IMPORTANT SAFETY INFORMATION

SAFETY SYMBOLS AND DEFINITIONS
Symbols used in this guide and on the product itself are identified to ensure correct usage, to prevent danger to the user and others and 
also to prevent property damage. The meanings of these symbols are described below.

NOTE: It is important that you read these descriptions thoroughly and fully understand the contents.

UV Radiation Hazard: Invisible UV radiation is accessible in the vicinity of this sign or behind the panel. Radiation can 
cause eye injury. Access panels are for service only and should be opened only by certified service personnel.

Electrical Shock Hazard: High voltage electricity is accessible in the vicinity of this sign or behind the access panel. 
High voltage can cause severe burns or death. Access panels are for service only and should be opened only by 
certified service personnel or trained maintenance personnel.

Hot Surface Hazard: A hot surface is accessible in the vicinity of this sign or behind the access panel. Avoid contact. 
Hot surfaces can cause severe burns. Access panels are for service only and should be opened only by certified service 
personnel or trained maintenance personnel.

Harmful Irritant Warning: Indicates that skin or eye irritation could result while exposed to a chemical composition.

Caution: Indicates something may happen that could cause loss of data, damage to equipment, or personal injury.

Pinch Point: Indicates hands and/or fingers potentially could be pinched when interacting with the equipment.

Wear Gloves: Wear gloves when handling uncured VisiJet® build material.

Ultraviolet Radiation Inside: Exposure may cause eye damage. Do not operate without covers. Wear UV eye 
protection.
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SAFETY GUIDELINES

General Safety Guidelines

To ensure personal safety, follow these general safety guidelines when operating the printing system.

•	 Follow all safety rules in this section and observe all cautions and warnings in this guide.

•	 Do not use print materials without first reviewing its Material Safety Data Sheet (MSDS & SDS) which can be found at http://
www.3dsystems.com/support/materials/msds. 

•	 To prevent tripping, ensure power and communication cables are located away from the walking path to the printing system. 

•	 If performing maintenance to this system, ensure step by step instructions and safety precautions are followed during the proce-
dure. 

•	 Operators of the printer should be trained to perform necessary tasks when printing a part according to the guidelines that are set 
forth in this manual. This includes understanding and following the safety and regulatory guidelines. 

•	 Do not modify any safety features or make modifications to the printing system. Doing so is prohibited and voids warranty and 
contractual agreements. 

•	 Use of part materials, print pads or parts other than genuine 3D Systems® ProJet® 1200 components may void warranty and other 
contractual agreements. 

•	 To prevent potential skin-irritation and sensitization due to contact with the print material, follow all guidelines in Material Safety 
Data Sheet (MSDS). 

•	 In the unlikely event that you are exposed to ultraviolet rays from the unit, proper precautions must be taken. To ensure your safety, 
UV protective eye wear and nitrile gloves should be worn when operating this equipment.

•	 Hazardous voltage exists inside the electrical module. Injury or death from electrical shock can result if the system’s electrical box 
covers are removed. When installing replacement modules, ensure the power is off before removing panels.

HIGH VOLTAGE POTENTIAL & ELECTRICAL SAFETY

High Voltage Potential
If the electrical module is in need of repair, power down the printer and unplug the 
power supply. Do not remove covers, doing so will void warranty and contractual 
agreements.

Electrical Safety
To operate the printer, the door must be closed. 

This printer requires a grounded, 1-phase electrical power source with a service 
rating of 100 to 240 VAC~, 50/60 Hz, 5 A (max.). 

ULTRAVIOLET (UV) SAFETY

Ultraviolet (UV) Safety

•	 In normal operation, the ultraviolet (UV) light is completely confined, so users are not exposed to potentially harmful emitted 
radiation.

•	 UV light from the printer could cause personal injury. Use recommended protective eye wear which blocks the UV light. It is 
recommended to never purposely stare directly into the printer during operation.

•	 To prevent eye injury, do not open the door when the ultraviolet (UV) light is activated. When the door are closed, it keeps UV 
radiation from escaping.

•	 Pay attention and follow the warnings contained in this guide concerning operation and printer’s maintenance procedures.

•	 If the door is opened during operation, use the recommended protective eye wear which blocks the UV light.

•	 Hazardous voltage exists inside the electrical module. Injury or death from electrical shock can result if the system’s 
electrical box covers are removed. When installing replacement modules, ensure the power is off before removing 
panels.
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CONSUMABLE SAFETY GUIDELINES

NOTE: Follow all safety rules in this section and observe all cautions and warnings in this guide.

VisiJet® FTX Green Cartridge
Uncured material waste is classified as regulated, and in some areas hazardous, thereby requiring special packaging, transportation 
and disposal. Refer to your local environmental regulatory agency.

Applicable material “waste” includes cartridges (empty or full). Any cleaning supplies used to clean up uncured material should be 
disposed of in the same manner as the uncured material. To identify which disposal requirement applies, contact the local waste 
disposal service provider. (The local environmental regulatory agency should have a list of qualified providers in your area.) Give the 
disposal service provider a copy of the material’s MSDS and the SNUR (Significant New Use Regulation - U.S. only). The service will 
provide a report, indicating the disposal requirements that apply, as well as a quotation for regularly scheduled pickups.

3D Systems assumes no liability or responsibility for proper disposal of the uncured material. Proper disposal of the uncured material is 
the sole responsibility of the user.

VisiJet FTX Green Cartridge Removal

Wear protective gloves when removing the material tray from the printer. Remove the tray and place it in a disposable 
bag. Be careful not to spill, drop or expose other materials to the waste.

NOTE: Partially used cartridges should be returned to their original packaging to store for later use.

VisiJet FTX Green Material Disposal
ProJet 1200 3-D printer operators should be informed about the potential hazards of part material prior to performing operations which 
may result in exposure to uncured material. This includes the removal and disposal of empty cartridges or unlikely spills that may occur 
during operation.

Leaks indicate a serious malfunction. The first priority is to protect users from inadvertently touching the material. Handling uncured 
material requires the use of gloves and other protective equipment to ensure there is no direct skin contact. If uncured spills occur, 
promptly remove the spilled material, and dispose of the waste material according to local environmental regulations.

If a problem with the printer occurs, discontinue use until the problem is diagnosed. Resolve the problem before continuing to operate 
the printer.

Small spills of uncured liquid can be cleaned up using disposable towels. After wiping the spill, wipe printer surfaces using a lint free 
cloth and clean with Isopropyl alcohol or window cleaner.

Cleaning spills on carpeting can be difficult. Avoid placing printer over carpeted areas or use a barrier to avoid the possibility of carpet 
damage. Advise any service provider involved (e.g. carpet cleaning service or disposal service) of the nature of the spilled material. 
Provide the MSDS and other material information prior to their contact to the material. Provide material disposal requirements and 
cleaning solutions if the material is uncured.

Tools that may be contaminated with the material should be cleaned prior to reuse. Recommended solvents such as IPA are normally 
required to clean tools. A final wash with soap and water will remove any excess of print material.

VisiJet FTX Green Material Handling
Upon receipt of the part material shipment, inspect the carton for signs of physical damage and evidence of leakage on the exterior. If 
leakage is observed, do not open carton; immediately contact 3D Systems’ Customer Support Hotline. If leakage is not present, store 
materials in their material kits until they are ready to use. Materials should be kept indoors in a cool, dry area with adequate ventilation 
with temperatures between 16°C (60°F) and 27 °C (80°F). DO NOT EXCEED A MAXIMUM STORAGE TEMPERATURE OF 35°C 
(95°F).

Keep materials away from direct sunlight, heat, flames and other direct light or UV energy sources. For optimal results, keep stored 
cartons closed and sealed until the cartridge is ready for use. Authorized 3D Systems VisiJet FTX Green Material should only be used 
in the printer.

VisiJet FTX Green Material Safety
Training: New users should be trained in the hazards and management of materials. Such training should be provided before they begin 
working with the printer or disposal of material waste.

Once the print material has completed its printing cycle, the print needs to be removed, cleaned and cured, rendering it safe to handle. 
When print material is uncured- meaning in a paste or wet form, do not touch uncured print material directly without protective gloves. If 
uncured material is observed, ensure the safe handling of uncured print material.
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Flammability and Combustibility: Do not expose print material to heat (at or above 110°C/ 230°F), flames, sparks, or any source of 
ignition. (Though the U.S. Department of Transportation does not consider this material a “flammability hazard,” they do classify it as 
combustible based on their flash points.) For more information on VisiJet® Material flash points and combustibility, see the VisiJet® 
Material MSDS/SDS packaged with the material cartridge.

Health Hazards: Any chemical may exert harmful effects if it enters or contacts the body in sufficient quantities. Uncured material is a 
sensitizer, and can cause allergic reactions if it comes in contact with the skin. Always wear chemically resistant protective gloves, nitrile 
or neoprene gloves are recommended. DO NOT use latex gloves. Consult the MSDS for specific information about the sensitization 
potential.

Sensitization dermatitis is the result of an allergic reaction to a given substance. In some cases, direct skin contact is necessary to 
cause sensitization. It is possible for individuals to become sensitized to a substance even after a trouble-free period of exposure. Many 
factors affect a person’s susceptibility including: existing skin conditions, personal habits, and individual sensitivity. Even slight exposure 
can sometimes trigger a severe outbreak of dermatitis. Since sensitization is permanent, a sensitized individual should avoid further 
contact with the sensitizing agent.

Inhalation: Under normal operation, inhalation is not an expected exposure method. To ensure personal safety, uncured print material 
should not be present where food and drink are stored, prepared or consumed. As a precaution, after handling material, wash hands 
with soap and water before handling food. Finished parts (cured) can be handled or disposed of in the same manner as standard 
household plastic products. These parts are not recyclable.

Exposure Control: The printer has a variety of built-in safety features that are designed to prevent operator exposure. Do not try to 
change or disable these features.

Personal Protective Equipment and Skin Protection: Exposure to uncured material may occur when removing and disposing spent print

cartridges. To prevent contact, wear chemically resistant protective gloves - nitrile or neoprene gloves are recommended. Wear safety 
glasses with side shields to provide eye protection in the event of a leak or spill of uncured print material.

Respiratory Protection: Because of the printer’s built in controls, respiratory protection is not necessary during normal operation. The 
status screen in the client software will prompt the user to change the printer’s air filters at prescribed times. Individual use may vary 
depending on the run time of the modeler. A NIOSH-approved (or equivalent) dust mask is recommended when dry sanding cured 
parts.

VisiJet® FTX Green Material Usage
The VisiJet FTX Green Material batch number and date code is indicated on the material kit label. For best results, please use materials 
by the date indicated. Before removing cartridge from its protective poly bag, and before loading it in to the printer, inspect the cartridge 
for signs of leakage or physical damage. Do not load cartridge that is leaking or is damaged. Dispose of it according to your local 
regulations.

ULTRAVIOLET (UV) SAFETY

CAUTION: Ultraviolet (UV) Safety

•	 In normal operation, the ultraviolet (UV) light is completely confined, so users are not exposed to potentially harmful emitted 
radiation.

•	 UV light from the printer could cause personal injury. Use recommended protective eye wear which blocks the UV light. It is 
recommended to never purposely stare directly into the printer during operation.

•	 To prevent eye injury, do not open the door when the ultraviolet (UV) light is activated. When the door are closed, it keeps UV 
radiation from escaping.

•	 Pay attention and follow the warnings contained in this guide concerning operation and printer’s maintenance procedures.

•	 If the door is opened during operation, use the recommended protective eye wear which blocks the UV light.

•	 Hazardous voltage exists inside the electrical module. Injury or death from electrical shock can result if system’s electrical box 
covers are removed. When installing replacement modules, ensure power is off before removing panels.
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3 	 AT-A-GLANCE

ABOUT THE PRINTER 
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A LCD Display

B Print Door

C Elevator Guide Rods

D Elevator

E Print Platform Clamp Lever

F Print Platform

G Material Cartridge Clamp

H Print Cartridge Support

I Material Cartridge Clamp Lever

J UV Curing Bulb Socket

K Curing Chamber Carousel

L UV Curing Bulb

M Curing Chamber Door

N Curing Chamber
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CONNECTIONS

A B C

A Ethernet

B USB

C Power Input
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4 	 SPECIFICATIONS AND REQUIREMENTS

SPECIFICATIONS

Printer

ProJet® 1200
Net Build Volume (xyz) 43 x 27 x 150 mm 

Native Resolution (xy) 56 micron (effective 585 dpi*)

Layer Thickness 0.03 mm (0.0012 in)

Vertical Build Speed 14 mm/hour (0.55 in/hour)

Material VisiJet® FTX Green

Material Packaging All-in-one cartridge with built-in print window

Post-processing Built-in UV Curing Station

Software

-Easy Installer

-Network Connection

-Windows®-based OS

-Built-in STL verification

-Automatic and optimized supports

File Input STL

Electrical Requirements 100-220V 50/60 Hz

Network Ready

* Enhanced LED DLP technology provides an effective resolution of 585 DPI.

Material Cartridge

VisiJet FTX Green
Properties Condition Value
Density@80° C (liquid) 1,02 g/cm3

Color Dark Green

Cartridge Quantity 30 g

Tensile Strength ASTM D638 30 MPa
Tensile Modulus ASTM D638 1700 MPa
Elongation at Break ASTM D638 10%
Flexural Strength ASTM D638 40 MPa
Ash Content 0.01 %

Description Wax-up Castable
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5 	 UNPACKING AND SETTING UP YOUR PROJET 1200

CONTENTS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A ProJet 1200

B VisiJet® FTX Green Consumable Tray

C Build Platform

D USB Cable

E Plastic Insert

F Power Supply

G UV Lamp

B

D

F

G

A

C
E
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UNPACKING THE PROJET 1200

CAUTION:  This procedure may require two persons.  Ensure there are enough people to comfortably move the 
printer to its final location.  Dropping the printer and parts may damage them.

CAUTION: Ensure that you save all foam and packing material for the future repacking of your ProJet 
1200.  Shipping the printer without original packing materials may cause damage to the printer and void the 
manufacturer’s warranty.

1.	 Pull the grip handle tabs (A).

2.	 Remove the grip handles from the box.

3.	 Lift the outer box off the printer.

A
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4.	 Remove the peripherals box (A) and the upper foam insert (B).

5.	 Carefully remove the printer from the lower boxed foam support and place it on 
a solid, level base where it will be used. 

CAUTION: Do not install the printer near direct sunlight. If the 
material cartridge is exposed to direct sunlight, the resin will begin 
to cure.

NOTE: There should be a utility power outlet and an active network 
port nearby.

NOTE: There should be a minimum of 6”/152 mm air space between 
the back of the printer and any other object.

NOTE: There should be at least 10”/254 mm air space on either side 
of the printer.

6.	 Remove the protective film (A) covering the display.

A

B

A
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7.	 Open the peripherals box and remove the USB cable (A), country specific 
power cord (B), print platform (C), curing bulb (D), power supply (E) and 
material cartridge (F).

NOTE: Keep the material cartridge away from direct light. UV light 
will begin to cure the print resin in the cartridge and render it 
useless.

8.	 Open the print door and remove the plastic insert (A) from the material 
cartridge support. 

NOTE: If necessary, lift the print material cartridge clamp lever (B) 
to gain more clearance.

NOTE: When installing the UV curing bulb, ensure the plastic insert 
is reinserted in the material cartridge clamp. The plastic insert  
is designed to protect the glass pane in the material cartridge 
support.

 

D

F

CA B

A

B

E
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PRINTER SETUP

Installing the Curing Bulb

CAUTION: Do not touch the curing bulb. Keep the protective sleeve on the bulb until after the bulb has been 
installed.

CAUTION: Exercise caution when installing the bulb. If the printer is rotated to its side or upside down, the 
glass plane under the material cartridge support assembly may dislodge or become damaged. It is strongly 
recommended that the packing foam is inserted into the material cartridge support and then the cartridge clamp 
secured with the material cartridge clamp lever.

1.	 Loosen and remove the screw securing the bulb access 
panel to the bottom of the printer and remove the panel.

2.	 Remove the bulb (included) from its box but do not 
remove the cardboard protective sleeve from the 
bulb.

3.	 Insert the bulb end with the metal prongs through the 
channel in the bottom of the printer.
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4.	 Carefully press the bulb base into the socket and 
ensure the connection is secure.

5.	 Remove the cardboard sleeve from the bottom.

6.	 Reinstall the bulb access panel on the bottom of the 
printer using the original screw.
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Installing the Material Cartridge

CAUTION: For best results, do not expose the material cartridge to excessive light. Light will begin to cure the 
material causing it to harden prior to printing.

Always wear protective gloves when installing or replacing a material cartridge.

1.	 Rotate the material cartridge clamp lever (B) upward to raise the cartridge 
clamp (A).

2.	 Fold over the material cartridge label.

3.	 Insert the material cartridge into the material cartridge support and then under 
the material cartridge clamp.

NOTE: The material cartridge will set into a pocket on top of the 
glass pane. 

A

B

CAUTION: It is very important that the cartridge be seated correctly 
in the pocket or else a leak can be created in the cartridge which 
may damage the system.
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4.	 Rotate the material cartridge clamp lever (B) down to lower the cartridge clamp 
(A).

NOTE: Ensure the clamp is locked.

5.	 Carefully pull the label cover off the cartridge.

Installing the Print Platform

Always wear protective gloves when handling the print platform.

1.	 Rotate the print platform clamp lever upward.

2.	 Insert the print platform under the clamp lever until it is seated.

A

B
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3.	 Rotate the print platform clamp lever down to lock the print platform.
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Installing the ProJet 1200 Software
3DS Central is the location where you can access user manuals, installation guides, service procedures, software and firmware 
information. You must create an account to gain access to these resources.

1.	 Go to https://3dscentral.3dsystems.com and enter your name and 
password.

2.	 Select Products.

3.	 Select Professional 3D Printers from the left navigation bar.
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4.	 Select ProJet 1200 from the dropdown menu.

5.	 Download the application software by selecting the filename under the software 
header.

NOTE: A window may open asking if you want to open or save the 
zipped file. Select your preferred option.

6.	 Double-click file that was just downloaded to begin installing software.
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Connecting The Printer
The printer is network-ready and easily connected.

1.	 Connect the A/C power cord to utility power and then connect the 
power supply to the power inlet (A) on the printer.

A

NOTE: After connecting the printer to utility power, a series 
of screens will appear as the printer boots up.

NOTE: This screen shows the firmware version number.

NOTE: This screen indicates that it is not connected to a 
network.

NOTE: This screen shows that the printer has completed the 
boot process and is ready to connect to a network.

2.	 If connecting to a network, connect the printer Ethernet port (A) to 
the network with an Ethernet cable. If connecting printer via USB 
connection see CONNECTING PRINTER USING USB CONNECTION 
below.

A

NOTE: Once the printer is connected to the network, the IP 
address will appear. 

CONNECTING PRINTER USING A USB CONNECTION
Follow Step 1 above, when LCD display shows ProJet 1200 Ready connect machine via USB cable and wait while machine installs all 
the necessary drivers for that particular printer on your computer. (This will take a couple of minutes).

Once updates are complete, and printer is connected, display will show the IP address. Continue on with Step 3 at this point.
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3.	 Open the ProJet 1200 application. Double-click the ProJet 1200 icon that was 
placed on your desktop during the software installation.

4.	 Select File > Connect to Printer.

5.	 Select the name of the printer next to the IP address of your printer. Select 
OK.

6.	 Test the connection by selecting File > Printer > Test Printer > Test Post 
Curing.

NOTE: The curing chamber carousel should rotate if the printer is 
connected.
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6 	 OPERATING THE PRINTER

The printer works in conjunction with the ProJet 1200 software (desktop client).

SOFTWARE OVERVIEW

A

H

B

E

C D

F

A File Menu

B Main Toolbar

C View Toolbar

D Edit Toolbar

E Tools Toolbar

F Stage

G Orientation Compass

H Status Bar

G
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A

B

C

D

E
F

G

H
I

J

K

L
M

N

O
P

A Add a CAD file to the project

B Load a sample file to test the printer

C Create supports for a model if necessary

D Modify existing supports if necessary

E Submit the job to process and print

F Submit the job from existing files

G Connect your computer to a network 
connected printer using the IP address

H Test printer functions and obtain firmware and 
cartridge information

I Check build status.  Also pause, resume and 
abort a build

J Tools for starting or stopping the curing 
process

K Save the part as a specific file type

L Save the platform as a compressed STL file

M Save the model view

N Save the platform as a compressed STL file

O Closes PrintPreview

P Not used for this printer

File Dropdown Menu
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Edit Dropdown Menu

A

B

D

F

H

J

L

N

P

R

C

E

G

I

K

M

O

Q

A Undo your last change

B Delete the selected part

C Copy the selected parts

D Mirror the selected parts

E Move the parts along the X and Y axis

F Rotate the part by degrees

G Scale the part

H View the part facing up

I View the part face down

J View the part on the X-Z plane

K View the part on the Y-Z plane

L Change the units of measurement type

M Select and move the part

N Select all parts

O De-select all parts

P Select the triangle supports to modify

Q De-select all triangle supports

R Enable/disable the editing of supports
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View Dropdown Menu

Tools Dropdown Menu

A

C

E

G

I

K

M

O

B

D

F

H

J

L

N

P

A Enable/disable the trackball view

B View the part at predetermined views 

C Zoom into the part

D

E Rotate the part left/right or in/out

F Select/deselect the preferences you wish to 
view

G Select either shaded or points animation 
options

H View the part either wireframe or shaded

I View the part properties

J Edit the light properties

K Set or hide the X-Y plane, X-Z plane and Y-Z 
plane grids

L View or hide the Main Toolbar

M View or hide the Edit Toolbar

N View or hide the View Toolbar

O View or hide the Tools Toolbar

P View or hide the Status Toolbar

A Verifies the part is complete

B Automatically places the part in a predetermined position.

A

B
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Options Dropdown Menu

Help Dropdown Menu

Main Toolbar

A Specify the units of measurement as inches or millimeters

B Not used for this printer

A

B

A Links to help documentatin on 3dscentral

B Revision information for PJP3P

A

B

A Add a part to the stage

B Select a part

C Select all parts

D De-select all parts

E Undo the last action

F Delete the selection

A B C D E F
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View Toolbar

Edit Toolbar

A B C D E F G H I J K L M N O P

A Trackball View - Left-click and drag to rotate 
the model

B Wireframe Display - View the model as a 
wireframe

C Shaded Display - View the model as shaded

D Display Support Creation  Surface - View the 
area where supports may be added

E Isometric view

F Top View

G Bottom View

H Front View

I Back View

J Left View

K Right View

L View the platform and parts

M View all parts

N View selected parts

O Zoom

P Undo zoom

A B C D E F G H I J K L M N

A Auto Part Placement - The software places the 
part in its optimized position

B Copy - Copy the selection

C Mirror - Mirror the selection

D Translate - Move the part along the X and Y 
axis

E Rotate - Rotate the part

F Scale - Scale the part

G Scale millimeter to inch

H Scale inch to millimeter

I Triangle selection

J De-select all triangles

K Align down-facing plane

L Align up-facing plane

M Align facing X-Z plane

N Align facing Y-Z plane
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Tools Toolbar

PRINTING A PART 
The ProJet 1200 software can open .stl files. Files must be converted to .vbf using the Print Preview software application. Double-click 
the PrintPreview icon on the desktop.  Ensure the material cartridge and the print platform have been installed.

1.	 Select File > Add CAD File, browse to the model and select Open.

2.	 Select the unit of measure to use when opening the part.

3.	 Under Edit > Scale

A B C D E F G

A Generate and preview supports

B Edit supports

C Create a job and return to Web 
browser

D Verify

E Estimate build time

F Selected part information

G Help topics
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NOTE: If the part has already been converted to a .vbf file type, select 
File > Submit Job from Existing File >

4.	 Uncheck Isometric Scale

5.	 Change the X and Y fields to 102.5% leave Z unchange

             NOTE: A window may appear saying “Automatic Part Placement 
             may take a while. Do you wish to continue?” Automatic Part 
             Placement is recommended, Select Yes.
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6.	 Select File > Submit Job.

NOTE: A dialogue box will appear instructing you to install the 
print platform and print cartridge. Once ready, select OK. You will 
be prompted to save the file.

7.	 Browse to the location where you intend to save the file and select Save.

NOTE: Enter the file name in the file name field and ensure PJP3P 
Build Files (*.vbf) as the Save as type is selected

NOTE: A progress indicator will appear as the part is processed.

NOTE: Once the part has been processed, it will begin printing.

NOTE: The printer LCD will display how much time remains before 
the print has been completed. You may also go to File > Build 
Status to determine the estimated print time.

8.	 Once printing has finished, the printer display will indicate that printing has completed. 

REMOVE THE PART FROM THE PRINTER
After the part has been printed, it must be processed. Refer to the following steps to complete post processing of the part. You will need 
a towel to catch resin that may drip from the part as well as two containers of 70% alcohol large enough to completely submerge the 
part. It is important to limit the exposure of the material cartridge to light. 

Always wear protective gloves during post process. 

CAUTION:  Always follow the precautions noted on the MSDS sheets for any chemical being used.

1.	 Place a towel under the part. Rotate the print platform clamp lever up enough 
to unlock the print platform.

NOTE: Resin may drip from the part. The towel is used to collect 
dripping resin so that printer parts are not exposed to resin.
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2.	 Pull the print platform handle (A) out from under the clamp.

NOTE: The part will hang down under the print platform.

A

CLEANING PARTS

The following equipment is needed for cleaning parts produced by the ProJet 1200.

Glass containers with lids

•	 16 oz, 

•	 3.5 inch diameter opening (minimum)

•	 This size will hold parts that are “ring height”.

Digital timer

99% isopropyl alcohol (IPA), optionally you may use 70% IPA

 Ultrasonic cleaner (Optional)

•	 Digital timer

•	 Volume: 28 liter (0.75 gal)

•	 Stainless steel Tank: 9 x 5 x 4 inch

Warning: 99% and 70% Isopropyl Alcohol.  Flammable liquid and vapor. Keep away from heat, spark and open 
flames. Use with adequate ventilation. Store at 68-86°F.  Do not take internally. Avoid prolonged or repeated 
breathing of mist or vapor. Causes irritation to eyes and respiratory tract.  Affects central nervous system.  May 
be harmful if absorbed through skin.  May cause irritation to skin.

Wear Gloves: Always wear gloves when cleaning parts.
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Cleaning Parts by Manually Dipping

1.	 Mark glass containers as “Container 1” and “Container 2”

2.	 Place print platform into Container 1.  

3.	 Add 99% IPA to Container 1.  Use enough IPA to completely submerse the parts.

4.	 Using the print platform handle, continuously dip and remove the part into Container 1 for 60 seconds.

5.	 Remove parts from Container 1.  Allow excess alcohol to drip from the parts for 30 seconds.

6.	 Place print platform into Container 2.  

7.	 Add 99% IPA to Container 2.  Use enough IPA to completely submerse the parts.

8.	 Using the print platform handle, continuously dip and remove the parts into Container 2 for 90 seconds.

9.	 Remove parts from Container 2.  Allow excess alcohol to drip from the parts for 30 seconds.

10.	 Use clean compressed air (not over 30 psi), to dry the part.

11.	 Inspect the part closely to make certain no liquid resin remains.  Pay particular attention to shiny areas.  The part may appear shiny 
even if there is no liquid resin remaining.  If you are unsure if liquid resin remains, it is best to repeat steps 8 through 10.

Make certain you replace the lids on Containers 1 and 2 when they are not in use.  
Containers 1 and 2 can be used to clean 12 platforms before discarding and replacing the IPA.

Cleaning Parts using an Ultrasonic Cleaner

1.	 Mark glass containers as “Container 1” and “Container 2”

2.	 Place print platform into Container 1.  

3.	 Add 99% IPA to Container 1.  Use enough IPA to completely submerse the parts.

4.	 Replace the lid onto Container 1.

5.	 With the ultrasonic cleaner switched off, place Container 1 into the ultrasonic cleaner.

6.	 Add water to the ultrasonic cleaner until the water level is approximately 6mm (1/4 inch) above the alcohol level in Container 1.

7.	 Switch the ultrasonic cleaner on for 60 seconds.

8.	 Switch ultrasonic cleaner off and remove Container 1 from the ultrasonic cleaner.

9.	 Remove parts from Container 1.  Allow excess alcohol to drip from the parts for 30 seconds.

10.	 Place print platform into Container 2.  

11.	 Add 99% IPA to Container 2.  Use enough IPA to completely submerse the parts.

12.	 Replace the lid onto Container 2.

13.	 Place Container 2 into the ultrasonic cleaner.  Make certain the water level is approximately 6mm (1/4 inch) above the alcohol level 
in Container 2.

14.	 Switch the ultrasonic cleaner on for 90 seconds.

15.	 Switch ultrasonic cleaner off and remove Container 2 from the ultrasonic cleaner.

16.	 Remove parts from Container 2.  Allow excess alcohol to drip from the parts for 30 seconds.

17.	 Use clean compressed air (not over 30 psi), to dry the parts.

18.	 Inspect the part closely to make certain no liquid resin remains.  Pay particular attention to shiny areas.  The part may appear shiny 
even if there is no liquid resin remaining.  If you are unsure if liquid resin remains, it is best to repeat steps 10 through 17.

Make certain you replace the lids on Containers 1 and 2 when they are not in use.
Containers 1 and 2 can be used to clean 12 platforms before discarding and replacing the IPA.
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Special Consideration when Cleaning Parts

When performing the cleaning procedures provided above, you may 
find that it is more difficult to remove the resin from certain parts or 
particular areas of a part.  The geomety of the part or the orientation of 
the part on the platform may result in the following:

•	 The part may hold a large amout of liquid resin in a cavity 

•	 An air bubble may be trapped preventing the isopropyl alcohol 
from contacting the part.

In these cases, change the orientation of the parts when cleaning.  
Rotate the print platform 90 or 180 degrees to release trapped air 
bubbles.  This will also expose areas of the part which are saturated 
with liquid resin, allowing better exposure to the isopropyl alcohol.

Changing the Isopropyl Alcohol in Containers 1 and 2

The isopropyl alcohol in Container 1 and Container 2 must be replaced after cleaning 12 platforms.  The discarded alcohol is 
contaminated with uncured resin and is considered hazardous waste.  The discarded alcohol must be stored and disposed of in 
accordance with all local, state and federal regulations.

Cleaning Parts with 70% Isopropyl Alcohol

You may use 70% (as opposed to 99%) isopropyl alcohol to clean parts.  Using 70% IPA requires the following minor modifications to 
the cleaning procedures:

•	 The cleaning times increase: 2 minutes in Container 1 and 90 seconds in Container 2.

•	 It will take longer to dry the parts with compressed air.

•	 The isopropyl alcohol in Container 1 and Container 2 must be replaced after cleaning 6 platforms.

The discarded alcohol is contaminated with uncured resin and is considered hazardous waste.  The discarded alcohol must be stored 
and disposed of in accordance with all local, state and federal regulations.
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CURE AND POST PROCESS THE PART

1.	 After the part is completely dry, insert the print platform onto the curing 
chamber carousel.

2.	 The curing chamber carousel has metal tabs on top that secure the print 
platform. Slide the print platform under the tabs.

3.	 Close and latch the curing chamber door.

4.	 Select File > Post Curing > Start.
5.	 Curing the part will take approximately 10 minutes. Do not open the curing 

chamber door until the curing process has been completed.

6.	 Once the part has been cured, remove the print platform from the curing 
chamber carousel.

7.	 Using a blade, carefully scrape the part off the print platform.

8.	 Use your fingers, remove the base from the part.

9.	 Use fine grit sandpaper to sand down the unwanted protrusions from the 
bottom of the part. 

10.	 Apply Isopropyl alcohol to a soft cloth and gently clean the part.
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7 	 USER MAINTENANCE

The following procedure are maintenance procedures that can be performed by the user.  When performing the following procedures, 
the user must follow all safety precautions as described in the Safety section of this manual.

REPLACING THE CURING BULB

CAUTION: Do not touch the curing bulb. Keep the protective sleeve on the bulb until after the bulb has been 
installed.

CAUTION: Exercise caution when installing the bulb. If the printer is rotated to its side or upside down, the 
glass plane under the material cartridge support assembly may dislodge or become damaged. It is strongly 
recommended that the packing foam is inserted into the material cartridge support and then the cartridge clamp 
secured with the material cartridge clamp lever.

1.	 Remove print platforms from the build chamber and curing 
chamber.  Remove material cartridge from the printer.

2.	 Place the original packing material on the material cartridge 
support and lower the clamp lever (B) to secure it. 

3.	 Loosen and remove the screw securing the bulb access 
panel to the bottom of the printer and remove the panel.

4.	 Reach up into the bulb housing area and hold the bulb 
between your fingers.  Pull down on the bulb and carefully 
rock the bulb left-right to dislodge the buld from the socket.

5.	 To replace the bulb, following the procedure, 
Installing the Curing Bulb on page 14.

A

B
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CLEANING THE UNIT
The internal parts of the build and curing chamber can be wiped clean with 70% isopropyl alcohol and a soft, non-scratching cloth, 
(such as a microfiber).  Make certain you inspect the glass that is a part of the print cartridge support.  Remove the glass and clean any 
resin, fingerprints or any other debris which may have accumulated.

 Glass

Print Cartridge 
Support
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8 	 SERVICE AND SUPPORT

Should additional questions arise, contact 3D Systems:

Service Contact

Hotline Every workday: 8:00 - 17:00 EST/EDT

1.800.793.3669

E-Mail moreinfo@3dsystems.com

Service Address

U.S.A

3D Systems Inc.

333 Three D Systems Circle

Rock Hill, SC 29730

Service Address

Japan

3D Systems, Japan K.K.

4-6-8 Tsurumaki

Setagaya-Ku, Tokyo 154-0016

ServiceAddress

Europe

3D Systems Europe Ltd.

Mark House, Mark Road

Hemel  Hempstead

Herts HP2 7UA

United Kingdom
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